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PARTE 1

Instalaciones necesarias

Java JDK 7.u78 (64-bit)
http://www.oracle.com/technetwork/java/archive-139210.html

ﬁJava SE Development Kit 7 Update 75 (64-bit) - Setup X

ORACLE

Welcome to the Installation Wizard for Java SE Development Kit 7 Update 75

This wizard will guide you through the installation process for the Java SE Development Kit 7
Update 75.

The Java Mission Control profiling and diagnostics tools suite is now available as part of the
JDK.

Eclipse Classic SDK 4.2.2 JUNO (64 bits)

https://eclipse.org/downloads/packages/eclipse-
classic-422/junosr2

@ Java - Edipse SDK - o X

File Edit Navigate Search Project Sample Run Window Help

= & Welcome © W

Welcome to Eclipse

Y Overview Tutorials
Get an overview of the features Go through tutonais

@, Samples What's New

Try out the samples Find out what s new

NCl Calnid


http://www.oracle.com/technetwork/java/archive-139210.html
https://eclipse.org/downloads/packages/eclipse-classic-422/junosr2
https://eclipse.org/downloads/packages/eclipse-classic-422/junosr2

Modificar archivo eclipse.ini, con la ruta y version de JRE instalada

-startup
plugins/org.eclipse.equinox.launcher_1.3.0.v20120522-1813.jar
-vm

C:/Program Files/Java/jre7/bin/javaw.exe

--launcher.library
plugins/org.eclipse.equinox.launcher.win32.win32.x86_64_1.1.200.v20120913-144807
-showsplash

org.eclipse.platform

--launcher.XXMaxPermSize

256m

--launcher.defaultAction

openFile

-vmargs

-Xms40m

-Xmx512m

-startup

..I..1..Iplugins/org.eclipse.equinox.launcher_1.3.0.v20120522-1813.jar

--vim
/Library/Java/JavaVirtualMachines/jdk1.7.0_80.jdk/Contents/Home/bin/java
--launcher.library
..I..1..Iplugins/org.eclipse.equinox.launcher.cocoa.macosx.x86_64 1.1.200.v20120913-144807
-showsplash

org.eclipse.platform

--launcher. XXMaxPermSize

256m

--launcher.defaultAction

openFile

-vmargs

-Xms40m

-Xmx512m

-Xdock:icon=../Resources/Eclipse.icns

-XstartOnFirstThread

-Dorg.eclipse.swt.internal.carbon.smallFonts

En MacOS para iniciar Eclipse, desde la consola:
./eclipse/Eclipse.app/Contents/MacOS/eclipse

Instalacidon paquete “Modeling”



Help > Install new software

Work with: Juno — http://download.eclipse.org/releases/juno

Search: Modeling

Seleccionar todo el paquete Modeling y “Next”

% Install

Available Software

Check the items that you wish to install.

Work with: | Juno - http://download.eclipse.org/releases/juno

v Add...

Modeling

Name
v @uﬂﬂ Modeling

Find more software by working with the “Available Software Sites” preferences.

Version A

1.2.0.201206050806

2.8.3.v20130125-0826

1.0.2.v20130212-0719
1.6.0.v20120327-2213-47F08xGD6FxMBN7C)...
1.6.2.201302122140

I 1.6.2.201302122140
1.6.2.201302122140
3.0.2.201301191623

|v|4* Eclipse Modeling Discovery Ul

Z@ EMF - Eclipse Modeling Framework SDK

Z@ EMF - Eclipse Modeling Framework Xcore SDK

Z{Dx Graphical Modeling Framework (GMF) Notation SDK

[7|% Graphical Modeling Fr k (GMF)

Z{u: Graphical Modeling Fr k (GMF) i E

[/|% Graphical Modeling Fr k (GMF) Runtime SDK

Z{u: Graphical Modeling Framework (GMF) Tooling

[/]4 Graphical Modeling Fr k (GMF) Tooling -

Select All Deselect All 10 items selected
Details

Show only the |atest versions of available software
Group items by category
[] Show only software applicable to target environment

Contact all update sites during install to find required software

Extensi 3.0.2.201301191623 V

[T Hide items that are already installed

What is already installed?

< Back Einish Cancel

Actualizar paguetes

Help > Check for updates

@ Information

No updates were found.

o



http://download.eclipse.org/releases/juno

Nuevo proyecto para crear herramienta grafica

File > New > Other > Graphical Modeling Framework > Graphical editor Project

Ingresar un nombre para el proyecto y “Finish”

9 New

Select a wizard

Creates new blank GMF project

Wizards:
type filter text
= Vs
& Edipse Modeling Framework
& Example EMF Model Creation Wizards
» & GMF-Xpand
~ & Graphical Modeling Framework
¢4 Graphical editor project
& Guide Mapping Model Creation
& Simple Graphical Definition Model
# Simple Tocling Definition Model
& Default
& Java
» & Java Emitter Templates
& Plug-in Development
» & User Assistance
& Other
» & Examples

< Back

% Graphical editor project

Graphical editor project

B> Creates new blank GMF project

Project name: | testprojecﬂ

Use default location

Location: | CG\Users\HP-envy\Desktop\workspace2\testproject

Browse...
Working sets
[ Add project to working sets
Working sets: ~ Select...
@ < Back Next > Cancel

¢ Package Explorer i
v 1 test
& src
> =i JRE System Library [jre7]
> =i Plug-in Dependencies
» = META-INF
&= model

NCl Qalnd




Creacidon del Metamodelo

File > New > Other > Graphical Modeling Framework > Ecore Model

Ingresar un nombre para el metamodelo y “Finish”

& New O X

Select a wizard

Create a new Ecore model

Wizards:

ecore

v = Eclipse Modeling Framework ~
&7 Ecore Model
v = Mapping
# Ecore to Ecore Mapping
#i Ecore to XML Mapping

v = Examples

@ < Back Finish Cancel

Tener en cuenta que se tuvo que utilizar una clase superior DSLSalud dentro del metamodelo, la cual mediante
agregacion contiene las demads clases, ya que luego para modelar graficamente se tomara una clase como punto de
anclaje de entrada, y se permitira graficar todas las clases que contengan dependencias desde la misma.

DSLSalud.ecore 52 = 0

<7xml. version="1.0" encoding="UTF-8"7>
<ecore:EPackage xmi:version="2.8" xmlns:xmi="http://www.omg.org/XML" xmlns:xsi="http://www.w3.org/28081/¥MLSchema-instance”
xmlns:ecbre:“http:ﬂm‘eclipse‘org/emFIEMZ/Ecore“ name="05LSalud" nsURI="gidas.frlp.utn.edu.ar" nsPrefix="dslsalud">
<eClassifiers xsi:type="ecore:EClass” name="DSLSalud" abstract="true"s
ceStructuralFeatures xsi:type="ecore:EAttribute” nome="name" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString"/>
<eStructuralFeatures xsi:type-"ecore:EReference” name-"hasPersons” upperBound-"-1"
eType="#//Person” containment="true"/>
<eStructuralFeatures xsi:type="ecore:EReference” name="hasOrganizations" upperBound=
eType="#//0rganization” containment="true"/>
<eStructuralFeatures xsi:type="ecore:EReference” name="hasEncounters” upperBound-
eType="#//Encounter” containment="true"/>
</e(lassifiers>
<eClassifiers xsi:type="ecore:EClass” name="Person
<eStructuralFeatures xsi: "ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EALEribute”
<eStructuralFeatures xsi: ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EAtkribute”
<eStructuralFeatures xsi: ecore:EAtkribute”
<eStructuralFeatures xsi: ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EAttribute”
</e(lassifiers>
<eClassifiers xsi:type="ecore:EClass” name="Organizatiof
ceStructuralFeatures xsi:type="ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EALEribute”
<eStructuralFeatures xsi: ecore:EAtkribute”
<eStructuralFeatures xsi: ecore:EAtkribute”
<eStructuralFeatures xsi: ecore:EAttribute”
<eStructuralFeatures xsi: ecore:EAttribute”
=eStructuralFeatures xsi:type="ecore:EReference”
upperBound="-1" eType="#//Encounter"/>
</eClassifiers>
<eClassifiers xsi:type="ecore:EClass" name="Encounter">
<eStructuralFeatures i "ecore:EAttribute”
<eStructuralFeatures ecore:EAttribute”
<eStructuralFeatures ecore:EAtkribute”
<eStructuralFeatures ecore:EAtkribute”
<eStructuralFeatures ecore:EAttribute”
<eStructuralFeatures ecore:EAttribute”

abstract="true">

"active" eType="ecore:EDataType http://waw.eclipse.org/emf/2002/Ecore#//EBoolean />
address" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString"/>
birthDate" eType-"ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString" />
gender” eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt"/>
dentifier" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt" />
name" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecored//EString"/>
"ecore:EDataType http://www.eclipse.org/emf/2002/Ecores//EString"/>
ecore:EDataType http://www.eclipse.org/emf/2802/Ecore#//EString" />

active" eType-"ecore:EDataType http://www.eclipse.org/emf/2002/Ecored//EBoolean”/>
address" eType-"ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString" />
alias" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString" />
dentifier" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt" />
name" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EString” />
ecom” eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecores/ /EString"/>
type" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecored//EInt"/>
serviceProvider” lowerBound="1"

"class" eType-"ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt" />
dentifier" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt"/>
length” eType="ecore:EDataType http://www.eclipse.org/emf/2082/Ecore#//EInt" />
periodFinish" eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecoref//EString™/>
periodStart” eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecores//EString"/>
eType="ecore:EDataType http://www.eclipse.org/emf/2002/Ecore#//EInt"/>
<eStructuralFeatures ecore:EAttribute” status” eType=-"ecore:EDataType http://www.eclipse.org/emf/2082/Ecore®//EInt"/>
ceStructuralFeatures ecore:EAttribute” type" eType="ecore:EDataType hitp://www.eclipse.org/emf/2002/Ecore#//EInt"/>
ceStructuralFeatures xsi:type="ecore:EReference” name="subject" lowerBound="1"

eType="#//Patient" />




Vista textual del Metamodelo (.ecore)

<?xml version="1.0" encoding="UTF-8"?>

<ecore:EPackage xmi:version="2.0" xmlns:xmi="http://www.omg.org/XMI" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-
instance"
xmins:ecore="http://www.eclipse.org/emf/2002/Ecore" name="dslsalud" nsURI="gidas.frlp.utn.edu.ar" nsPrefix="dslsalud">

<eClassifiers xsi:type="ecore:EClass" name="DSLSalud">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EReference" name="hasPersons" upperBound="-1"
eType="#//Person" containment="true"/>
<eStructuralFeatures xsi:type="ecore:EReference" name="hasOrganizations" upperBound="-1"
eType="#//Organization" containment="true"/>
<eStructuralFeatures xsi:type="ecore:EReference" name="hasEncounters" upperBound="-1"
eType="#//Encounter" containment="true"/>
<eStructuralFeatures xsi:type="ecore:EReference" name="hasEpisodesOfCare" upperBound="-1"
eType="#//EpisodeOfCare" containment="true"/>
</eClassifiers>

<eClassifiers xsi:type="ecore:EClass" name="Person" abstract="true">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="active" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/>
<eStructuralFeatures xsi:type="ecore:EAttribute" name="address" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="birthDate" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="gender" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#t//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="surname" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="telecom" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
</eClassifiers>

<eClassifiers xsi:type="ecore:EClass" name="Patient" eSuperTypes="#//Person">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="maritalStatus" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="deceased" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/>
</eClassifiers>

<eClassifiers xsi:type="ecore:EClass" name="Practitioner" eSuperTypes="#//Person">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="qualification" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
</eClassifiers>

DSL Salud



<eClassifiers xsi:type="ecore:EClass" name="0Organization">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="active" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EBoolean"/>
<eStructuralFeatures xsi:type="ecore:EAttribute" name="address" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="alias" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="name" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="telecom" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EReference" name="serviceProvider" lowerBound="1"
upperBound="-1" eType="#//Encounter"/>
</eClassifiers>

<eClassifiers xsi:type="ecore:EClass" name="Encounter">

<eStructuralFeatures xsi:type="ecore:EAttribute" name="class" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="length" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="periodFinish" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#t//EString" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="periodStart" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="priority" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="status" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />

<eStructuralFeatures xsi:type="ecore:EReference" name="subject" lowerBound="1"

eType="#//Patient"/>
<eStructuralFeatures xsi:type="ecore:EReference" name="episodeOfCare" lowerBound="1"
upperBound="-1" eType="#//EpisodeOfCare"/>
</eClassifiers>

<eClassifiers xsi:type="ecore:EClass" name="EpisodeOfCare">
<eStructuralFeatures xsi:type="ecore:EAttribute" name="identifier" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="periodFinish" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="periodStart" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EString" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="status" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EAttribute" name="type" eType="ecore:EDataType
http://www.eclipse.org/emf/2002/Ecore#//EInt" />
<eStructuralFeatures xsi:type="ecore:EReference" name="careManager" lowerBound="1"
eType="#//Practitioner"/>
<eStructuralFeatures xsi:type="ecore:EReference" name="patient" lowerBound="1"
eType="#//Patient"/>
</eClassifiers>

</ecore:EPackage>

DSL Salud



Vista grafica del Metamodelo (.ecore_diagram)

Cuando el archivo DSLSalud.ecore esta listo se puede inicializar el diagrama asociado al metamodelo haciendo clic
derecho sobre el archivo y apretando la opcidn “Initialize ecore_diagram file”. Esto nos generara el archivo
DSLSalud.ecore_diagram.

Es importante no hacer cambios sobre el diagrama visual, ya que la correlacidon con el metamodelo XML no es directay lo
modificara haciéndolo incompatible con herramientas que se deberdan utilizar en pasos posteriores.

D5LSaled
hasPersans E =
| D name : EString hasEncounters
hasEpisodesOfCare !
hasOrganizations
g..* g0." 0.*
H Persan [ orgarization H Encaunter
O active : EBoolean O active : EBoolean = class @ Eint
= address : EString = address : EString = identifier : Eint
O birthDate : EString o alias : EString = length @ Eint
O gender : Eint = identifier : Eint serviceProvider 1. .| = periodFinish : EString
o identifier : Eint O name ! EString = periodStart @ EString
O name : EString O telecom @ EString = priority : Eint
O sumame ! EString = type : Eint = status : Eint
O telecom @ EString = type : Eint
% %
g ratient | Practitioner
1 maritalStatus : Elnt o qualification : Eint
= deceased : EBoolean
o+ |[E EpisodeniCar
o identifier : Eint S
o periodFinish : EString |_ 1" s ®
1.1 careManager | O periodStart : EString
O status @ Elnt
1.1 patient | & type : Eint
subject
1.1

NSI Salud



PARTE 2

Crear herramienta grafica para instanciar un Modelo

Window > Show view > Other > GMF Dashboard

. Problems ® GMF Dashboard

@ Graphical Def Model

<not specified>

Select/Edit/Create

# Domain Model

:

) >
Select / Edit / Create Select / Edit/ Create

B Domain Gen Model # Tooling Def Model @Diagram Editor Gen Model
<not specified> <not specified> <not specified>
Select/Edit/Reload Select/Edit/ Create Select/Edit/ Create
Generate diagram editor

El dashboard muestra todo el proceso que deberemos realizar para crear una herramienta grafica que nos permita
modelar e instanciar un modelo utilizando nuestro metamodelo anteriormente creado.

Domain Model (.ecore)

El primer paso sera cargar el metamodelo como Domain Model (.ecore). A partir de este punto todo se “construird”
sobre el metamodelo que seleccionemos. Avanzamos con la premisa de que el metamodelo es correcto y contiene todos
los elementos deseados que esperamos poder utilizar en el plugin graficador.

Apretando en “Select” y tomamos nuestro metamodelo desde nuestro workspace.

Select a resource to open (? = any character, * = any string):

Matching resources:

M dslsalud.ecore

In folders:
= dslsalud/model

| Show derived resources

@ cance

DSL Salud



Domain Gen Model (.genmodel)

Derivaremos nuestro Domain Model hacia un Domain Gen Model (.genmodel) utilizando el botén “Derive”. Esto nos
creara un modelo de generador de cédigo que nos dara el cédigo de salida de nuestro modelo y permitira instanciar

nuestro modelo. Es la base del plugin graficador, aun sin informacion de diagrama y herramientas que se utilizaran para
graficar.

Primero se seleccionara donde guardar, que elegiremos la carpeta model. Luego se seleccionara el tipo de nuestro

modelo, que serd “Ecore model”.

EMF Generator Model -
E Select a Model Importer H._
Create the generator model
g E Create the Ecore model based on other Ecore or EMOF models E
Enter or select the parent folder: Model Importers:
dsisalud/model @ Annotated Java
H ™ Ecore model
¥ =% dslsalud ‘-;J Ecore model (CDO Native)
(= .settings @) Rose class model
» (=bin }1 UML model
(= META-INF j‘Xcore
(= model |S] XML Schema
> =src
» =2 dslsalud.diagram
» =2 dslsalud.edit
n 124 delealid aditnr
File name: = dslsalud.genmodel
Advanced >>
®@ Cancel @ <Back Cancel

Luego se cargara el metamodelo para que sea validado apretando “Load”. Y finalmente se seleccionara el paquete
dentro del metamodelo que contiene la informacién del dominio, en nuestro caso “dslsalud”.

Ecore Import H— \ Package Selection g‘
Specify one or more "ecore’ or .emof' URIs and try to load them ?: Specify which packages to generate and which to reference from other generator
models
Model URIs: Browse File System... Browse Workspace... Root packages: Select All Deselect All
platform:/re / / | d.ecore Load Package File Name
# dslsalud dslsalud.ecore
Referenced generator models: Add...
® < Back Cancel ® < Back Cancel




Una vez creado el dslsalud.genmodel lo abrimos y verificamos que esté todo el contenido de nuestro metamodelo.

[tz dslsalud.genmodel 3

7 Dslsalud

V¥ 8 Dslsalud
> [] DSLSalud
> [ Person
> [ Organization
» [ Encounter
> [] Patient -> Person
> [ Practitioner -> Person
> [ EpisodeOfCare

Si esta todo bien, apretamos clic derecho sobre la raiz y seleccionamos la opcion “Generate All”.

[iz dslsalud.genmodel £3

| (A0

v

Generate Model Code
Generate Edit Code
Generate Editor Code
Generate Test Code

Generate All

vvvvvvvii

EEF >

Progress Information

Operation in progress...

IJ * ~—

Cancel

Esto nos generara en el workspace el codigo del Editor, Modelo y Testing del plugin en las carpetas ds/salud.edit,
dsisalud.editory dslsalud.tests que utilizaremos utilizaremos mas adelante.

NSI Salud



Graphical Def Model (.gmfgraph)

Derivaremos nuestro Domain Model hacia un Graphical Def Model (.gmfgraph) utilizando el botén “Derive”. Esto nos
crearad un modelo de definiciones gréficas que contendrd todos los elementos gréficos a utilizar en nuestro plugin
graficador. Seleccionamos nuestro metamodelo .ecore y seleccionamos la clase principal para nuestro diagrama, en este
caso “DSLSalud”, que es la clase extra que agregamos en el metamodelo para tomar como punto de anclaje.

GMFGraph Model
Create a new GMFGraph mode!

Enter or select the parent folder:

dslsalud/model

V\Dstlsalud
(= .settings
» (= bin
=>META-INF
(=~ model
b (=sre
> \UstIsalud.diagram
» =2 dslsalud.edit

o 12 Aclealid aditar

File name:  dslsalud1.gmfgraph

Advanced >>

@ [ Next > I

Domain Model

Select file with ecore domain model.

st

Model URI: Browse File System... Browse Workspace... Find In Workspace...

platform:/resource/dslsalud/model/dsisalud.ecore Load

Diagram Element:
DSLSalud
Encounter
EpisodeOfCare
Organization
Patient

Person
Practitioner

1/’?) < Back

T e

» o«

Luego marcamos las “entidades”, “relaciones” y “atributos” de nuestro cada clase de nuestro metamodelo. Es importante

dejar a la clase DSLSalud sin marcar.

Graphical Definition

Domain model elements to process:

Element
v | DSLSalud
= name : EString
it hasPersons : Person

SrhasEncounters : Encounter

» H Person

v [ Organization
= active : EBoolean
= address : EString
= alias : EString
= identifier : EInt
= name : EString
= telecom : EString

(?) < Back

Specify basic graphical definition of the domain model.

SrhasOrganizations : Organization

42 hasEpisodesOfCare : EpisodeOfCare

iz Ll
B A
Deselect All
Defaults
V]
¥
v
v
¥
V]
cance | (GEENS

Es importante en este punto, mirar con especial la clasificacién de “entidades”, “relaciones” y “atributos” que se haga, ya

que la funcionalidad del editor grafico dependera de ello.

Haciendo clic en “Finish” se creara nuestro Graphical Def Model dentro de nuestro workspace.




Tooling Def Model (.gmftool)

Derivaremos nuestro Domain Model hacia un Tooling Def Model (.gmftool) utilizando el botdn “Derive”. Esto nos creara
todas las herramientas graficas en las que se hara clic para dibujar nuestros modelos. Seleccionamos nuestro
metamodelo .ecore y seleccionamos la clase principal para nuestro diagrama, en este caso “DSLSalud”.

Luego marcamos las “entidades” y “relaciones” de nuestro metamodelo al igual que en el paso anterior. Nétese que
ahora sélo se puede marcar entre “entidad” y “relacion” ya que este archivo de configuracién sera integramente para la
caja de herramientas, dénde sélo se pueden seleccionar entidades o relaciones.

GMFTool Model \ Domain Model
Create a new GMFTool model ¢ Select file with ecore domain model. ¢
G 2 S R PR el Model URI: Brows¢ Browse Workspace... Find In Workspace...
dslsalud/model
platform:/resource/dslsalud/model/dslsalud.ecore Load
v '[;%dslsalud
= .settings Diagram Element:
> & bin DSLSalud
(= META-INF Encounter
(=~ model EpisodeOfCare
» &= src Organization
» (=2 dslsalud.diagram Patient
Person

. Practitioner
File name:  dslsalud1.gmftool

Advanced >>

§ R
) Cancel @ <ack | MIEENM  cancel

S

Tooling Definition

Specify basic tooling definition of the domain model. ¢
=L

Domain model elements to process:

Element &

£ DSLSalud ] Deselect All

S hasPersons : Person

52 hasOrganizations : Organization Defaults
&2 hasEncounters : Encounter
52 hasEpisodesOfCare : EpisodeOfCare

[ Person

¥ [ Organization |
5 serviceProvider : Encounter

¥ [ Encounter M
5*subject : Patient
5 episodeOfCare : EpisodeQfCare

[ Patient -> Person M
= - —

100000 OO00O0

@ < Back Cancel m

Haciendo clic en “Finish” se crearan las herramientas graficas Tooling Def Model dentro de nuestro workspace.



La configuracidn base que se cred tiene todas las entidades y relaciones en el mismo nivel. Para una major legibilidad,
abrimos y editamos manualmente al archivo dslsalud.gmftool.

Lo que se hace es crear dos “Tool Group” haciendo click derecho sobre Palette ds/saludPallete > New Child > Tool Group.

En el primer grupo pondremos todos los Creation Tools de entidades, y en el segundo todos los de relaciones. Con esto
nuestra paleta de herramientas estara dividida en dos, con entidades por un lado y relaciones por el otro.

Como paso extra, reemplazamos los iconos base que cada herramienta tenia por un icono mas representativo en cada
caso. Esto se hizo modificando la direccién de “Bundle Image” desde sus Propiedades. Los nuevos iconos deben ir en la
carpeta dslsalud.edit/obj16 y dslsalud.edit/obj32.

42 dslsalud.gmftool 52

E;' Resource Set

v ﬁ platform:/resource/dslsalud/model/dsisalud.gmftool
¥ <4 Tool Registry
¥ 4 Tool Group Entities
¥ <+ Creation Tool Organization
<4 Bundle Image ficons/full/obj32/Organization.gif
¥ <+ Creation Tool Encounter
<4 Bundle Image ficons/full/obj32/Encounter.gif
¥ <+ Creation Tool Patient
<4 Bundle Image ficons/full/obj32/Patient.gif
¥ <+ Creation Tool Practitioner
<4 Bundle Image ficons/full/obj32/Practitioner.gif
¥ <+ Creation Tool EpisodeOfCare
<4 Bundle Image /icons/full/obj32/EpisodeQfCare.gif
¥ < Tool Group Connections
V¥ <+ Creation Tool OrganizationServiceProvider
<4 Bundle Image /icons/full/obj16/Link.gif
¥ <+ Creation Tool EncounterSubject
< Bundle Image ficons/full/obj16/Link.gif
¥ <= Creation Tool EncounterEpisodeOfCare
<4 Bundle Image /icons/full/obj16/Link.gif
¥ <+ Creation Tool EpisodeOfCareCareManager
<4 Bundle Image /icons/full/obj16/Link.gif
¥ <+ Creation Tool EpisodeOfCarePatient
< Bundle Image ficons/full/obj16/Link.gif

[‘_ Problems (@ Javadoc [l Console @ GMF Dashboard Properties &3

Property Value
Bundle '= dslsalud.edit
Path 1= ficons/fullfobj32/Organization.gif




Mapping Model (.gmfmap)

Combinamos nuestro Domain Model (.ecore), Graphical Def Model (.gmfgraph) y Tooling Def Model (.gmftool), utilizando
el botdn “Combine”. Esto nos creara un Mapping Model (.gmfmap) que mapeara cada definicidn grafica con una
herramienta grafica para luego poder crear un nuevo modelo.

Este archivo es el mas importante del proceso GMF, ya que sera el encargado en unir todas nuestras configuraciones
anteriores.

Lo primero que se hace es ponerle el nombre dslsalud.gmfmap y que se guarde dentro de la carpeta model. Luego se
selecciona la clase raiz de nuestro modelo de dominio, en nuestro caso DSLSalud.

GMFMap Model Select Domain Model

Create a new GMFMap model| Load domain model and select element for canvas mapping.

Enter or select the parent folder:

Model URI: Browse File System... Browse Workspace... Find In Workspace...
dslsalud/model
i platform:/resource/dslsalud/model/dslsalud.ecore Load
v iD‘J dslsalud
(= .settings } Use one of the predefined models:
P (= bin
(= META-INF Package:  dslsalud B
(=~ model
P (= src Class:
b (=2 dslsalud.diagram DSLSalud
> iD‘J dslsalud.edit Encounter
b 12 delealiid aditar EpisodeOfCare
) Organization
File name: _ dslsalud.gmfmap| Patient
Person

Advanced >> Practitioner

7N
GUEEN | cancel @ <sack WMD)  cance

Luego se selecciona el elemento base del Tooling definition model (dslsalud.gmftool) y su elemento raiz, en nuestro caso
dsisaludPalette. Finalmente se selecciona el Grafical definition model (dslsalud.gmfgraph) y su elemento raiz, en nuestro
caso dslsalud.

Select Diagram Palette Select Diagram Canvas
Load tooling definition model and select diagram palette for canvas mapping. Load graphical definition model and select diagram canvas for canvas mapping.
Model URI: Browse File System... Browse Workspace... Find In Workspace... Model URI: Browse File System... Browse Workspace... Find In Workspace...
platform:/resourc /model/dslsalud.gmftool Load platform:/resource/dslsalud/model/dslsalud.gmfgraph Load
Diagram Palette: ~ dslsaludPalette a » Use one of the predefined models:
Create new model Diagram Canvas:  dslsalud B

@ [ Finish ]
@ < Back [ Next> | Cancel (?) < Back Next > Cancel




Esto nos habra creado en el workspace un archivo dslsalud.gmfmap. Lo abrimos y veremos que esta dividido en 4
regiones: gmfmap, ecore, gmfgraph, gmftool.

Abrimos la regién gmfmap y modificamos los “Mapping” de forma tal que que todos los “Link Mapping” estén
correctamente mapeado ya que hasta este momento no configuramos “qué entidad se puede relacionar con qué

entidad”.

Los “Top Node Reference” > “Node Mapping” seran las entidades, verificar también que estén todas.

& dslsalud.gmfmap 3%

E;i Resource Set
v ﬁ platform:/resource/dslsalud/model/dslsalud.gmfmap
¥ < Mapping
¥ )] Top Node Reference <hasPersons:Practitioner/Practitioner>
¥V )] Top Node Reference <hasEncounters:Encounter/Encounter>
» Il Node Mapping <Encounter/Encounter>
¥ )1 Top Node Reference <hasPersons:Patient/Patient>
» Il Node Mapping <Patient/Patient>
¥ ) Top Node Reference <hasEpisodesOfCare:EpisodeOfCare/EpisodeOfCare>
» Il Node Mapping <EpisodeOfCare/EpisodeOfCare>
¥ ) Top Node Reference <hasOrganizations:Organization/Qrganization>
» Il Node Mapping <Organization/Organization>
=% Link Mapping <{Encounter.episodeOfCare:EpisodeOfCare}/EncounterEpisodeOfCare>
=% Link Mapping <{Organization.serviceProvider:Encounter}/OrganizationServiceProvider>
=% Link Mapping <{EpisodeCQfCare.careManager:Practitioner}/EpisodeOfCareCareManager>
=% Link Mapping <{EpisodeQfCare.patient:Patient}/EpisodeQfCarePatient>
=% Link Mapping <{Encounter.subject:Patient}/EncounterSubject>
Canvas Mapping
b | platform:/resource/dslsalud/model/dslsalud.ecore
» nplatform:/resource/dslsalud/model/dslsaIud.gmfgraph
> ﬁ platform:/resource/dslsalud/model/dslsalud.gmftool

En caso de tener que modificar se hara desde la solapa “Propiedades”, que puede abrirse haciendo clic derecho sobre el
elemento y abajo de todo apretando la opcién “Show Properties View”

Problems Javadoc Console @ GMF Dashboard E Properties &3

Property Value
¥ Domain meta information
Containment Feature
Element
Source Feature
Target Feature 5t Organization.serviceProvider:Encounter
P Misc
V¥ Visual representation
Appearance Style

Context Menu
Diagram Link <= Connection OrganizationServiceProvider
Tool < Creation Tool OrganizationServiceProvider




Diagram Editor Gen (.gmfgen)

El paso final serd apretar el botdn “Transform” para compilar y unir todos los archivos en un Diagram Editor Gen Model
(.emfgen) y asi generar el editor que luego utilizaremos para modelar.

Cuando se cree el archivo dslsalud.gmfgen apretamos sobre el mismo clic derecho y seleccionamos la opcién “Generate
diagram code”.

e dslsalud.gmfgen &2

|[|>:| Resource Set

il
> [ platf
> &) platf

L=| Copy

4

Validate

Open Selected Resource In MoDisco Browser

Run As >
Debug As >
Profile As >

Add extension model...

Generate diagram code

Team »
Compare With »
e Generate diagram code ] X

P L
H Generation in progress...

DiagramPrintingPreferencePage

background

Run in ﬁackground| ‘ Cancel ‘ | Details >>

% Generate diagram code X

@ Code generation completed successfully.

[_IiNever show me this dialog again.

NSl Salird



Ejecutar la herramienta modeladora grafica

Clic derecho sobre la carpeta ds/salud.diagram generada > Run as > Eclipse application

ASSIgN WOTKING Sets...

> 7 1 Eclipse Application X 38X E
Debug As > =i 2 Java Applet ¥X A
Profile As > | [313JavaApplication 38X J
LS . > | % 40SGi Framework X$XO
Compare With >
Restore from Local History... Run Configurations...
"4 Discovery >
% Paste BV

Se abrird una nueva instancia de Eclipse con nuestro plugin graficador pre-cargado.

Se podra ver el estado de la ejecucidon del plugin y finalizarlo apretando el botén rojo de Stop en la pestafia “Consola”.

Problems @ Javadoc B Console 32 @ GMF Dashboard ] EEESE #E-ri-= 8

New_configuration [Eclipse Application] /Library/Java/JavaVirtualMachines/jdk1.7.0_80.jdk/Contents/Home/bin/java (Nov 7, 2017 3:13:32 PM)
T T BT T TP ST AT TS S R T N OT RO ST T AT S L R SIS e Ve ST

at org.eclipse.ui.internal.Workbench.access$7(Workbench.java:2441)

at org.eclipse.ui.internal.Workbench$5.run(Workbench.java:586)

at org.eclipse.core.databinding.observable.Realm.runWithDefault(Realm. java:332)

at org.eclipse.ui.internal.Workbench.createAndRunWorkbench(Workbench.java:543)

at org.eclipse.ui.PlatformUI.createAndRunWorkbench(PlatformUI.java:149)

at org.eclipse.ui.internal.ide.application.IDEApplication.start(IDEApplication.java:124)

at org.eclipse.equinox.internal.app.EclipseAppHandle.run(EclipseAppHandle. java:196)

at org.eclipse.core.runtime.internal.adaptor.EclipseAppLauncher.runApplication(EclipseApplLauncher.java:110)
at org.eclipse.core.runtime.internal.adaptor.EclipseAppLauncher.start(EclipseApplLauncher.java:79)
at org.eclipse.core.runtime.adaptor.EclipseStarter.run(EclipseStarter.java:353)

at org.eclipse.core.runtime.adaptor.EclipseStarter.run(EclipseStarter.java:180)

at sun.reflect.NativeMethodAccessorImpl.invoke@(Native Method)

at sun.reflect.NativeMethodAccessorImpl.invoke(NativeMethodAccessorImpl.java:57)

at sun.reflect.DelegatingMethodAccessorImpl.invoke(DelegatingMethodAccessorImpl.java:43)

at java.lang.reflect.Method.invoke(Method. java:606)

at org.eclipse.equinox.launcher.Main.invokeFramework(Main.java:629)

at org.eclipse.equinox.launcher.Main.basicRun(Main. java:584)

at org.eclipse.equinox.launcher.Main.run(Main.java:1438)

at org.eclipse.equinox.launcher.Main.main(Main.java:1414)
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PARTE 3

Crear un nuevo modelo grafico

Una vez abierta la nueva instancia de Eclipse tendremos que crear un nuevo proyecto desde
File > New project > General > Project

Ingresamos un nombre a nuestro proyecto, en este caso test.

[ ] L ] Java - Eclipse SDK

5 @ welcome % o rAaBee
& .
@‘s.e [ 3
Workbench

Welcome to Eclipse

Q Overview Tutorials
Get an overview of the features S Go through tutorials
@<, Samples _/\_ what's New
“»  Try out the samples /" Find out what is new

@ ® New Project ® ® New Project
Select a wizard —> Project
Create a new project resource [ Create a new project resource. B
Wizards:
Project name:  test
124 Java Project Use default location
£ Java Project from Existing Ant Buildfile .
1,2 Plug-in Project Location:
¥ (= General :
werkng sets

» (= Acceleo Model to Text
» (= Agent Modeling

P (= ATL Working sets: <
> (=CVS

P (= Eclipse Modeling Framework

» (== Ecore Tools

P (- EMF Facet

P (= Graphical Modeling Framework

| Add project to working sets

~ | Show All Wizards.

@ Cancel @ <Back - Cancel

Una vez creado el nuevo proyecto se procederd a crear nuestro diagrama DSL_Salud. Para ello iremos a

NSI Salud



File > New file > Examples > DSLsalud Diagram

Escribimos el nombre de nuestro nuevo diagrama, en este caso serd default dentro de nuestro proyecto test.

[ NON ) New Example

Select a wizard —

Creates Dslsalud diagram. |

Wizards:

|d] Acore Diagram
P = Acceleo Plug-ins
> (= ATL
» (= CDO Model Repository
P = Eclipse Modeling Framework
P (=~ EGF Examples
P = EMF Model Query Plug-ins
P = EMF Model Transaction Plug-ins
P = EMF Validation Framework Plug-ins
P = GEF (Graphical Editing Framework)
P (= GEF (Graphical Editing Framework) Plug-ins
P = GMF (Graphical Modeling Framework) Diagrams

" | Show All Wizards.

? BT Ccencel
File name: ' default.dslsalud_diagram
Advanced >>
@j < Back Next > Cancel m

Esto ultimo nos creara:

- un archivo que contendrd nuestro modelo default.dslsalud (siendo .dslsalud la extensién relacionada a nuestro
metamodelo que se llama “dslsalud”)

- un archivo que contendra nuestro diagrama default.dslsalud_diagram (que serd el diagrama asociado a nuestro
modelo)

{% Package Explorer 3 s Y= 8

V =*test
|| default.dslsalud
default.dslsalud_diagram

» Otra posibilidad hubiera sido crear solamente nuestro modelo via texto desde File > New file > Other > Dslsalud
Model. Lo que nos crearia sélo el archivo default.dslsalud y deberiamos editar escribiendo sobre el mismo
directamente cddigo XML.



Con esto tendremos listo el proyecto y archivos necesarios para comenzar el desarrollo de nuestro modelo default.
A laizquierda tendremos la visualizacién de los modelos y diagramas que tengamos dentro de nuestro proyecto.
En el centro tendremos la ventana de edicién grafica de nuestro modelo.

A la derecha tendremos la paleta de opciones disponibles para crear nuestro modelo. La misma estara dividida en Entities
y Connections.

.= Palette b
NEECY=E
N ~“N r
[~= Entities <o

ﬁ Organization
Encounter
&

@ Patient

‘ Practitioner
% EpisodeOfCare
&

[~ Connections £
" OrganizationServiceProvider
" EncounterSubject
" EncounterEpisodeOfCare
o EpisodeOfCareCareManager
o EpisodeOfCarePatient

Ahora sélo nos restara dibujar nuestro modelo utilizando herramienta de la paleta.

Todo lo que se “dibuje” ademas serd mapeado directamente a nuestro modelo default.dslsalud de forma textual.

id| default.dslsalud_diagram &2

@other
a U 4 B

Add Patient 1H) orgenization ﬁ?,l encounter

i greher fhdfher
*
m P




Codigo ejemplo default.dslsalud

*default.dslsalud £2

<?xml version="1.0" encoding="UTF-8"?>

<dslsalud:DSLSalud|xmi:version:"Z.O" xmlns:xmi="http://www.omg.org/XMI"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:dslsalud="gidas.frlp.utn.edu.ar">

<hasOrganizations name="Hospital San

<hasEncounters periodStart="|
<hasEpisodesOfCare periodStart=
</dslsalud:DSLSalud>

Cdédigo ejemplo default.dslsalud_diagram

|| *default.dslsalud [} default.dslsalud_diagram 53

<?xml version="1.0" encoding="UTF-8"7>
<notation:Diagram xmi:version="2.0" xmlns:xmi="http://www.omg.org/XMI" xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"” xmlns:dslsalud="gidas.frlp)
<children xmi:type="notation:Shape” xmi:id="_bJLq4MPJEee9ke9nrBm04Q" type="2001" fontName=".SF NS Text">
<children xmi:type="notation:DecorationNode" xmi:id="_bJP8UMPJEee9keInrBm04Q" type="5001"/>
<layoutConstraint xmi:type="notation:Bounds" xmi:id="_bIMR8MPJEee9keInrBm04Q" x="163" y="42"/>
</children>
<children xmi:type="notation:Shape"” xmi:id="_cxAkUMPJEee9ke9nrBm04Q" type="2003" fontName=".SF NS Text">
<children xmi:type="notation:DecorationNode" xmi:id="_cxAkUsPJEee9ke9nrBm04Q" type="5003"/>
<element xmi:type="dslsalud:Patient" href="default.dslsalud#//@hasPersons.0"/>
<layoutConstraint xmi:type="notation:Bounds" xmi:id="_cxAkUcPJEee9keInrBm04Q" x="45" y="225"/>
</children>
<children xmi:type="notation:Shape"” xmi:id="_f-S_sMPJEee9ke9nrBm04Q" type="2002" fontName=".SF NS Text">
<children xmi:type="notation:DecorationNode" xmi:id="_f-TmwMPJEee9keInrBm04Q" type="5002"/>
<element xmi:type="dslsalud:Practitioner” href="default.dslsalud#//@hasPersons.1"/>
<layoutConstraint xmi:type="notation:Bounds" xmi:id="_f-S_scPJEee9keInrBm04Q" x="279" y="225"/>
</children>
<children xmi:type="notation:Shape" xmi:id="_jZGSoMPJEee9ke9dnrBm04Q" type="2005" fontName=".SF NS Text">
<children xmi:type="notation:DecorationNode" xmi:id="_jZGSosPJEee9keInrBm04Q" type="5005"/>
<element xmi:type="dslsalud:Encounter” href="default.dslsalud#//@hasEncounters.@"/>
<layoutConstraint xmi:type="notation:Bounds" xmi:id="_jZGSocPJEee9keInrBm04Q" x="207" y="153"/>
</children>
<children xmi:type="notation:Shape” xmi:id="_n65p4MPJEee9ke9InrBm04Q" type="2004" fontName=".SF NS Text">
<children xmi:type="notation:DecorationNode" xmi:id="_n65p4sPJEee9keInrBm04Q" type="5004"/>
<layoutConstraint xmi:type="notation:Bounds" xmi:id="_n65p4cPJEee9keInrBm04Q" x="162" y="367"/>
</children>
<styles xmi:type="notation:DiagramStyle" xmi:id="_aYueUcPJEee9ke9nrBm04Q"/>
<element xmi:type="dslsalud:DSLSalud" href="default.dslsalud#/"/>
<edges xmi:type="notation:Connector"” xmi:id="_1kw48MPJEee9keInrBm04Q" type="4005" source="_blLg4MPIEee9keInrBm04Q" target="_jZGSoMPIEeedkeInrBm04Q">
<styles xmi:type="notation:FontStyle"” xmi:id="_1kw48cPJEee9keInrBm04Q" fontName=".SF NS Text"/>
<element xsi:nil="true"/>
<bendpoints xmi:type="notation:RelativeBendpoints" xmi:id="_lkw48sPJEee9ke9dnrBm04Q" points="[5, 20, -19, -91]$[28, 131, 4, 20]"/>
</edges>
<edges xmi:type="notation:Connector" xmi:id="_pjIL8MPJEee9keInrBm04Q" type="4004" source="_jZGSoMPJEee9keInrBm04Q" target="_cxAkUMPJEee9ke9nrBm04Q">
<styles xmi:type="notation:FontStyle" xmi:id="_pjIL8cPJEee9keInrBm04Q" fontName=".SF NS Text"/>
<element xsi:nil="true"/>
<bendpoints xmi:type="notation:RelativeBendpoints” xmi:id="_pjIL8sPJEee9keIdnrBm04Q" points="[-17, 14, 92, -77]$[-87, 94, 22, 3]1"/>
<sourceAnchor xmi:type="notation:IdentityAnchor” xmi:id="_pjPgsMPJEee9ke9nrBm04Q" id="(0.2833333333333333,0.125)"/>
<targetAnchor xmi:type="notation:IdentityAnchor” xmi:id="_pjPgscPJEee9kednrBm04Q" id="(0.7608695652173914,0.6)"/>
</edges>
<edges xmi:type="notation:Connector” xmi:id="_r19mYMPJEee9keInrBm04Q" type="4002" source="_jZGSoMPJEee9keInrBm04Q" target="_n65p4MPIEeeIkeInrBmO4Q">
<styles xmi:type="notation:FontStyle" xmi:id="_r19mYcPJEee9ke9nrBm04Q" fontName=".SF NS Text"/>
<element xsi:nil="true"/>
<bendpoints xmi:type="notation:RelativeBendpoints" xmi:id="_r19mYsPJEee9ke9nrBm04Q" points="[-5, 20, 38, -181]$[-42, 194, 1, -7]"/>
<targetAnchor xmi:type="notation:IdentityAnchor" xmi:id="_rmFiMMPJEee9ke9nrBm04Q" id="(0.5423728813559322,0.175)"/>
</edges>
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